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The printed reports in InView and StockView can be customized to suit your needs. You adjust the
various object-oriented elements already created in HindSight software to fit your letterhead design
or change fonts or add graphic elements. To edit or not to edit the report designs is a question of
your style and the printer you use.

We’re often asked why we don’t include more information about how to make specific types of
changes to particular reports or labels. There are just too many reports in InView & StockView to
make it practical. Instead we’ve done our best to introduce you to the tools and techniques for mak-
ing adjustments.

Many reports do include notes within the window from which they print. For instance, Catalogue’s
caption label windows list the label stock for which they were designed and Contact’s rotary file
cards include card stock information as well as Page Setup tips. Check windows prior to graphics
editing to see if such tips are present. They may save a great deal of time.

Printouts are pre-designed for printers. Most compatible printers for your computer accept our set-
tings with no trouble, but odd printers, different fonts and graphic elements occasionally require
you to make simple modifications. Most reports are preset for US Letterhead, 8.5 x 11 inch, paper
with a top margin of 1.5 inches to accommodate many letterheads without modification. 7ip §

Reports include some of the data within their file and exclude other data. Reports may also include
conclusions drawn from the data. You can change where and how information is displayed on the
screen and positioned for printing. You can, if you like, install graphics in some reports.

Reports organize information from your files in a variety of ways for printing. Sometimes the report
simply prints what is there. Other times reports perform calculations using the data and the results
are printed. As a result, some reports, like envelopes, are very simple graphically, while others are
extremely complex, like an Invoice that gathers information from a number of places to print and
calculates and show the results, or the Address Book that has multiple, dynamic columns and prints
odd and even pages.

Don’t let this scare you off. One of the advantages of HindSight software is that you can modify
virtually anything that prints. Unless you know what you’re doing though, your first graphics edit-
ing should be a simple one, not a major overhaul of a Delivery Memo with Images due yesterday!
The graphics are easy if you approach them properly. Some people learn to swim by diving in. All
unguarded swimming pools post advisories, and so do we. Rather than sink or swim, we suggest
you start in shallow water. Read before you leap... and weep. Tip #

EZ GRAPHICS

We hate to call it the wading pool because there’s so much you can do with EZ Graphics, but it is
as safe as graphics changes get. EZ Graphics is available to some degree in all reports. How can
you find out where it is? Well, look at the menus of a report. If any of the following menus are list-
ed, that report has EZ Graphics.

EZ GrRaAPHICS MENUS

With EZ Graphics you make menu selections to modify a report. EZ Graphics covers many modi-
fications needs, but has fewer features than the full Graphics Mode. You will probably make some

simple modifications using EZ Graphics and other, more complex Company Info

adjustments in Graphics Mode if and when you read and become famil-
Company Name

iar with that.
Company Address

REPORTS

Tip:

In many cases, Page
Setup, In the File
menu, is the only ad-
justment necessary to
adjust margins prop-
erly. If your Page
Setup window has an
option for Maximum or
Larger Print Area, this
moves the printing up
and to the left by
about a quarter inch on
the page.

Tip:

Before attempting to
modify the graphics of
a report, cover yourself
with a fresh backup.

FONT Company Phone

The Font menu is limited to six common fonts found on all Macintosh
or Windows computers. The menu does not indicate the current font

Company Logo
+ All Company Info

settings of the report. For that you need full Graphics Mode.

Choose a font from the Font menu to set the entire report to that font.
Current font attributes, point sizes and type styles, remain the same. For
instance, a bold, 24 point plain word and a 10 point italicized word each

off !

keeps those characteristics as you change from one font to another. The Up/Down

one exception is Company Info in the report. It has a separate control Left/Right
described below. (See Company Info.)

If you choose Other... in the font choices, a dialog box opens where Font >
you enter a font not listed in the menu. To make this work, the font | Size >
name must be spelled exactly correctly and must be installed in the Style »
computer’s Fonts folder. Justification [

&




Manually altering
size or position of
the Data tile, or its
contents, in either of
these report forms
has the potential of
rendering this fea-
ture inoperable.

rintin
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Warning!

Warning!

If you delete
Company Name,
Company Address,
Company Phone,
Company Logo, or
All Company Info in
the full Graphics
Mode it can not be
adjusted in EZ
Graphics.
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MARGINS

Topr, BorTTOM AND LEFT
Each of these three choices opens a dialog window where you enter the number of inches for that
margin. In this case, the current setting is displayed. Accuracy is to 100ths of an inch, two places

after a decimal point. m

Note: Not all printers are made equal. Setting margins smaller than a half inch [ Tgp

may result in some parts of your printout being cut off. There are variances on | pgttom
how close to the edge printers are willing to put ink to paper. For most printers

this is about .5 inches. The larger print area option in some Page Setup dialogs can m
bring the printing area to within .25 inches of the paper edge. Remarks

REMARKS
Available only in the Margins menu of Worksheet and Stocksheet reports, Remarks increases or
decreases the area for the Remarks to print. The Margin settings dialog shows the current height of
the Remarks area. You enter the size, in inches, for the desired height of the Remarks box.

SHow/HIDE ITEMS
Available only in Worksheet’s Summarized Estimate and Summarized Invoice, this toggles the line
by line items on or off by adjusting the Data tile. When the Items are set to Show, the reports
become a combination of the Itemized and Summarized reports. § Warning!

CoMPANY INFO
The Company Info menu determines the appearance and position of information from the Company
Profile window of Flow Chart.

Note: If any of the “Don’t” buttons are checked in the Flow Chart Company Profile, those elements
won’t work in reports no matter what you do in the reports themselves.

Note: If you want the Company Info elements in a report that lacks these menus, it can be done
using Graphics Mode. Use EZ Graphics to get the fonts, sizes and such looking the way you want
them. Now choose Graphics Mode from the Windows menu. The elements you’ve configured are
there, but they now say CoName, CoAddress and CoPhone. The Logo looks pretty much the same.
Click once on any one that you want to move to another form. Shift-click on any others that you
wish to move. (See Selecting Objects later in this chapter.) Choose Copy from the Edit menu. Now
go to the report in which you want the elements. Put it in Graphics Mode and Paste. Use the Pointer
Tool to position them as desired and you’re done.

YOUR LoGgo
A logo is not controlled through the Company Profile window of Flow Chart. Place a graphic file
named Logo in the HindSight folder. That’s all that’s necessary. (See Computer Generated Logo
near the end of this chapter for information about adding a digital logo.)

ComMPANY NAME

CoMPANY ADDRESS

CoMPANY PHONE

ComMPANY LOGO

ALL CoMPANY INFO
Before you can adjust any of the Company Info elements, specify the one to affect with your menu
choices. When you choose one, a checkmark appears beside it in the menu to show what you’re
about to change. § Warning!

The Company Logo can be moved with the following commands, but ignores those that don’t apply
to it, such as change font size.

All Company Info applies modifications you choose to all of these at once.

ON
To use any elements of the Company Info they must be turned On. Select Company Info elements
above) and turn them On.

Note: Reports that can use Company Info are shipped with them all turned Off.
OFF

When you choose this, Company Info elements with a checkmark in the menu are banished into the
electronic ozone. Luckily, the On setting knows how to get them back.

HindSight Ltd.
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Up/DownN
If you choose Up/Down a dialog window opens where you enter positive (+) or negative (-) inch-
es to indicate how and how much to move the Company Info elements checked. Negative numbers
move objects up. Positive numbers move them down. Numbers with neither a plus nor a minus are
considered positive.

LEFT/RIGHT
A dialog window opens when you choose Left/Right. To move the Company Info checked in the
menu, enter a negative number for left, or a positive number for right. The objects move left or right
by the amount specified.

FoNT, Size, STYLE AND JUSTIFICATION
Company Info elements, except for the Company Logo, with a checkmark are changed to the font,
size, style and justification you select here. Current settings are not displayed in this menu.

Both Font and Size show Other... as your final choice. Other... opens a dialog box where you enter
a font name or size other than those listed in the menu. Font names must be spelled exactly right
and the font must be in the system’s Fonts folder.

GrRAPHICS MODE
The Big Time. Before you start to change things around we strongly advise you to read ahead in
this chapter then carefully and experiment with changes on a “modification copy” of your software,
not on the original working copy. There’s nothing like experimentation on a safe copy to really learn
how this works. Sure beats trying to repair a botched editing job in your working files.

Take a look at EZ Graphics, above. It’s not just for sissies. EZ Graphics lets you adjust margins and
fonts in many reports without any sweat or swearing. In fact, you may discover that using EZ
Graphics first makes the job in Graphics Mode a whole lot easier.

There are too many reports built into InView & StockView to elaborate on each here. Each has char-
acteristics of its own. If you learn to use the graphics tools, you should be safe to work on them.

How T0 MAKE A MODIFICATIONS COPY
Modifying Reports takes a little time and planning. Do yourself a favor. Set aside some unhurried
time to do this rather than wait until the last twenty minutes before you must mail or fax an Estimate
to a client or dash off an important letter.

The first step is to make a copy of the file with the Reports you want to modify. For clarity sake,
let’s use Worksheet as an example. The steps for making a modification copy of Worksheet apply
to any other file that has reports you want to modify.

To BEGIN
Make sure Worksheet is closed. Make the modification copy at the Desktop level. Open the
HindSight software folder. Highlight the Worksheet file by clicking once! (Don’t click twice. That
opens the file.) On Macintosh, go to the File menu and select Duplicate. A duplicate file called
Worksheet copy appears below the Worksheet file you highlighted. On Windows, go to Edit and
choose Copy, then Paste. A new file named Copy of Worksheet appears. With way, that’s your mod-
ification copy to work on.

Double-click the Worksheet copy and you’re ready to safely make changes in the Report forms.
Later, the entire modified copy, or parts of it you change, is substituted for the working file’s report.
As your confidence is runs higher, you can risk working in the original, but, even then, be sure to
make a copy as a safety net... just in case.

MAKING MODIFICATIONS
Each report that can be edited has Graphics Mode in the Windows menu. To make changes you
must be in Graphics Mode. If you click on the Graphics Mode tool in the palette, Panorama’s usual
access to Graphics mode, there is a beep and nothing more. InView and StockView gain access via
Graphics Mode, located in the Windows menu or Cmd/Ctrl-Y. At last, you’re ready to start making
adjustments.

To exit the Graphics Mode window click the T-square and triangle icon (Switch to Data
Mode) at the top of the tool palette. -

Note: If you activate Company Info in a report, the Company Info elements show as the simple
equations for CoName, CoAddress and CoPhone. In Graphics Mode you can move them, resize
them change the fonts or other attributes. If you delete them, you’re destined for error messages
the next time you try to use EZ Graphics. If Company Info elements are in your way, we suggest
you move them.

&
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Warning!

Deleting tiles or
moving elements
from one tile to an-
other can have con-
siderable impact on
a report. Until you're
more experienced
with re-designing re-
ports it's best to
stick to simpler
changes such as
just repositioning
items on a tile or
changing fonts.

Protect yourself
with backups no
matter how experi-
enced you think you
are with graphics.

HindSight Ltd.
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ELEMENTS OF A REPORT

Reports are printed from templates; windows designed to assemble all the pieces of data into a vari-
ety of meaningful configurations. Knowing what the basic elements of these templates are and what
they do makes it much easier to successfully modify them for different results.

TILES
When you first open any report template, the first thing you may notice is that it’s broken into sev-
eral parts. The largest parts of a report are the tiles. Tiles look a lot like window shades.

They’re called tiles because they are tiled together to create the total report.

The white area of a tile represents the paper on which the report is to be printed. Only text and
graphics within the white area of a tile are printed.

The report pictured here
is for an envelope; a
very simple report. It
consists of a Data tile
and two margin tiles,
Top Margin and Left,

represented by an Do o
arrow.It doesn’t matter
where these tiles are »
located within the win-

dow. They are properly

assembled when printed.

A
ZCompang
TAdEasy

The Top Margin’s vertical height controls how far the paper advances
through the printer before the main tile, the Data tile, is handled. The Left
Margin tile influences how much area the printer will ignore along the left
edge. Increasing and decreasing these tiles controls where the printed por-

tion of the report begins. >
Note: The illustration to the right shows how the margin tiles influence is

applied to the envelope report illustrated above. You would never actually assemble the tiles in this
manner.

Some reports are much more complex and involve a greater number of tiles. In addition to the Top
and Left margin tiles, an invoice utilizes several additional tiles.4 Warning!

The First Page Header is the top of the first page.
The white area we’ve left at the top of the layout is
available for your name and logo whether printed by
the program or already on pre-printed stationary.

LR
Compauys
e

Any additional pages start off with the Header tile
which is pictured at the bottom of our layout. The
fact that it’s at the bottom doesn’t matter. The soft-
ware knows that it represents the top of all addition-
al pages.

R
i
¥

iy, ufititen  «Zip Colen
Coustrys

The Data tile is the most used tile. It gets repeated
for as many lines as there are items in the report. An
invoice with 30 items repeats the Data tile 30 times. ~
A contact report prints the Data tile repeatedly for as
many Contacts have been selected for the report.
Letters in the Correspondence file consist of one
large Data tile.

o ot d sad b £ 0,04, s i

TSR0 eanes v B a0
H i TaxRate )+

To00,8vTun" T @

Many reports utilize a Footer tile. It serves as a bot-
tom margin and often contains and text or graphics
to be printed at the bottom of every page of the
report.

ubje iy
of iuvoiee date. All expenses are subject o 20

The rest of the tiles tend to be specialized and are
only used to print, or suppress, certain types of data.
Summary Tiles for instance, print various levels of
totals and subtotals in an invoice. Group Headers provide headings for different groups of items in
the report.

Tuvodre Fumder lookup{"Forks
Re: {lookup{ Vorkshet",

When a tile’s height is set to zero, with no white showing, it suppresses that piece of information
from being printed.
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The size of each tile has considerable influence over the printed result.
The height of the tiles added together equal the length of the report with some exceptions. Some
tiles, such as the Data tile, are used repeatedly. An invoice with 20 items repeats the Data tile once
for each item. If some of the items make up groups with subtotals, the report may use the Summary
1 tile at least a few times and so on. If all of this adds up to more than the page length, as set in
Page Setup, the report goes on to as many additional pages as necessary.
Tile height controls how much vertical space is devoted to each tile’s purpose. When any tile is
shortened vertically the overall report is shortened too. Shorten a Data tile that is about to print for Tip:

20 items and the overall difference is 20 times the amount of the change. A 2 inch wide Data tile
) ) ) o o ) doesn't always yield
Tile width influences the results too. If the Data tile in a report is 3 inches wide and the Page Setup q%ur a%ross OHT%H 85X

: : . L. INc age. e

is for US Letterhead (8.5 X 11 inches), the soft- {50 or « $we0, Sobtotal ) add up page appa\r/-
ware recognizes that there’s room to use the tiles  y2(7ax.0 "Sales Tax @ "«str{TaxRate)+"®", | ently acceptable eight
side by side. This technique is especially useful “Total Fees and Expenses inches, but that may
with caption labels for 35mm slides. In this case the tiles have . ” Bﬁ ggec;lglﬁfi% Soarf}[/:ru;l_
been set small enough to allow the Data tile to be reproduced {#{«$n»<0 “Baiance Due-.~ } ¥ lowing for its built in

four times on each line Tip » left and right margins.

TEXT BLOCKS

When you switch a form into graphics mode you see that the tiles are usually covered with dotted

boxes containing text. Sometimes the text is easy to read, other times it appears to be a lot of gib- Mg_.
berish. Sometimes we want literal phrases to print in our reports, but much of the time we want Reports in the

Graphics Mode have
equations designed

All of this text is created and/or edited using the Text tool on the graphics mode tool IE to locate and install

interpreted text to be printed. Warning! §

; PRI data or perform
palette. To use the Text tool, click on it’s icon. functions required

Static text, text that simply prints as it looks, is created by clicking into some open space and typ- for a report.

; , . - Messing with these
ing whatever words you want. After they’ve been typed they can be resized and repositioned as you equations means
desire. This same text is edited or modified by clicking into it wherever the changes are to be made. chaos. Equations are
text between and in-

Merge text is text that is replaced by the actual contents of the fields in the file. For instance, con- cluding these brack-

tact names ar stored in the Contacts field of the Contacts file. To have a report respond to whichev- ets:{ } Unless you
er name is being used at the moment, a report in the Contacts file needs to merge the Contact field are an expert
into the report. This requires only the name of the field bracketed in chevrons, « and ». The field Panorama user, do
name must be spelled and capitalized exactly as they are in the file. not rewrite or make
changes in the
To alleviate the need for you to figure all of this out, a very handy feature ] wording or se-
is included with the Text tool. Find some open space to work in within the : quen{:_e of th_(taﬁe ‘
window. It doesn’t matter where because you can move and resize things | = ﬁrqs%aré%gisn\a”abgﬂt
later. With the Text tool selected, click and drag the mouse to create a rec- equation writing and
tangle then release the mouse button. A blinking cursor should now g Ty date patterns. You
be inside a dotted rectangle. S Address can change the font
S rdamee | City style or s i
1 igdddresss tyle Or Size Oor_posi
With the mouse located anywhere over the box, hold the Cmd/Ctrl ™ o state tion of things. That
key, then click and hold the mouse button. A menu pops up right i ’ Zip Code does not affect how

things function, just
how they look when
printed.

where you clicked,listing all of the available fields in this particular
file. Choose one and it gets entered, chevrons and all, ready to drop °
in the appropriate data.

Several fields can be added together in a single text box or they can each be given a box all their
own.

Static text and Merge text can be used together in a single text box, but anything between chevrons
must be a proper field name or it prints as static text, chevrons and all.

the file to produce interpreted results. iUpper(«Ciontacts)} at«Commpanys
Formulas can perform math, rephrase £ 13%t than {datepatemitodaz()+7,"DayOfWeek, Month dd ¥y}
data or decide whether circumstances
are such that they should print any-
thing at all. Formulas are enclosed in

curly brackets, { and }.

Pleaze deliver to:
MARTY KLIENTEL at The Plutocratc Advisor
o later than Bunday, October 10 1999

It’s not our objective to teach you about formula writing here. That’s considered a more advanced
subject than the intended scope of this manual.

As with static and merge text, formula text can exist with the same text as the other, but alterations
between the curly brackets must be made properly or else it prints something like “Operand expect-
ed but not found!” instead of what you intended.

&
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Tip:

Use this method only
if you need to place
some other text, or ob-
ject, to the left of exist-
ing objects on tiles.
The EZ Graphics
Margins menu, Left
Margin, works won-
derfully for a simple
left margin adjust-
ment.

Tip:

[tems that are not
within the white area
of the tiles do not
print. If you need a
Text box, or any other
graphic object, out of
your way, consider
moving it into the gray
area to the side of the
tiles rather than delet-
ing it. Objects in this
grey area do not print.
You can keep all sorts
of spare parts on hand
for possible future use.
To restore these parts
just drag them back
onto their tile.

J

Warning!

Do NOT change the
type of a Report tile
(Data, Header,
Footer, Summary,
etc.) . Do not delete
a tile, even if it has
no data. Empty tiles
are a certain type
and dimensions for
a reason. Monkey
with these and you
create significant
changes in your
printed reports. It's
not a pretty sight.

HindSight Ltd.
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Fonts Note: You can’t have more than one font in one style and one size in a text box. For exam-
ple, you can’t have part of a text box print in Palatino Plain and a word or two in Palatino Bold.
Similarly, you can have only one size font per text or graphics box but you’re not stuck with only
one look per report. You can use several different fonts and/or font styles in a report that has a num-
ber of individually styled text boxes.

CHANGING GRAPHICS OBJECTS

All of the parts in a report form are graphics objects. Resizing tiles, text boxes or other graphics
objects affects the appearance of data on the page when you print a report.

SELECTING OBJECTS
Graphic objects in a report form must be selected to be affected. In order to reposition,
resize or change fonts, it must be selected! Objects are selected by clicking on them with
the Pointer tool. To make a simple change, such as a different font, move around in a report
clicking on the objects, one at a time, and make the change. To select several objects at once, Shift-
click the objects to change and apply the change to all the selected objects.

Lassoing means to drag a rectangle around a group of objects
using the arrow cursor tool. Lasso several graphic objects to
select a group of objects at once. Objects not entirely
enclosed by the lasso are not selected. Font changes or
realignment applies to the entire selected group.

Make an easy left margin adjustment
by lassoing everything in the report
while leaving the tiles extending out-
side the lasso. Next hold the Shift key
to constrain movement to a perfectly
horizontal axis, depress the mouse on
any of the selected objects and drag
left or right. They all move as a single
unit. Vertical alignment is unaffected.

¢Tip #Tip

e ee
i t
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SELECT ALL OBJECTS

Select All Objects, in the Edit menu of
Graphics Mode, selects everything in
the report form. Changing fonts, say
from Arial to Times, doesn't affect
other attributes such as sizes or style,
so a 10 point word in bold stays 10
point bold. Tiles and lines selected by
Select All Objects aren’t affected by a
change of fonts.

REsize TIiLES

Resizing tiles affects the location and
spacing of information printed in a
report. Adjust the vertical height of
certain tiles to temporarily accommo-
date more or less information.
¢ Warning!

The Remarks text in Worksheet serves
as a good example. Pull the bottom of
the Header tile up or down, and then
resize the Remarks text box to control the space allotted to Remarks, more or less as your needs
vary from one job to another.(As you resize, hold the Shift key to maintain the tile’s width and thus
the right and left margins.)

Note: The EZ Graphics Margins menu of Worksheet and Stocksheet reports easily increases or
decreases the area for the Remarks to print. The Margin settings dialog shows the current height of
the Remarks area. You enter the size, in inches, for the desired height of the Remarks box.

To include or exclude information in Reports such as in the Group Header (2) and Summary (2)
tiles of Worksheet, increase the vertical dimension to show information or decrease it to hide it.
Remember, text boxes must be entirely inside the white portion of a tile to print. Not 99% in or large
gaps appear in your print outs. If you Decrease a tile to its smallest vertical dimension and leave
the text box in its original size, you exclude the information in the text box and the tile from your
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printout. (Again, hold down the Shift key as you
decrease the size to maintain the right and left dimen-
sions.) Instructions for this appear in the window of

forms that have this option.

Click on the Drag Bar of a tile to select it. Use the
corner handles, below, to resize it or click and
drag on the Drag Bar to move it to the new posi-
tion.

& Crag Bars

To resize tiles and other graphic objects, click and
drag on the handles (small black squares) at the
corners.

To move Graphic objects, click inside the object
and drag it to a new position.

wCofnpanys
é« Address:
B Cit‘;g w, ¢ States k« Zip Codes

If you accidentally resize or delete anything, there is a path to recovery. Use Revert to Saved or, if
you already saved the changes, make another copy of your working file and try again. You are
working on a modification copy, yes?

PRECI

SION REsIzZzING

Any of the methods we’ve described leave a lot to be desired when you want to make accurate
adjustments to a hundreths of an inch or a centimeter.The mouse is pretty much a hit and miss

proposition when it comes to fine tuning.

With any single text box or a tile selected, go the the
Edit menu and choose Dimensions. The window that 437 +293
opens displays the exact location and sizes of the & Inches

: 0.6l (O Centimeters
selected object. 3 Pixels
The numbers coming from the top left corner repre- (—
sent the position within the window at which the o Absolute ® Relative
object starts. In most cases as long as you leave the

radio button setting on Relative, all you need to worry about is where the object ends.

The highlighted box in the lower left indicates the vertical size of the object and the box in the top
right indicates the horizontal size of the object. If you need a tile to be eight and a quarter inches
wide, change the top right number to +8.25, click OK and it’s done - exactly.

GrRAPHICS MoODE ToOoOLS
When a form is in Graphics Mode, the tool palette contains several tools with substantial design
and report building capabilities.

The Data Mode tool gets you out of Graphics Mode. Use it to Print or Preview the results
of your efforts.

The Pointer tool is used to select, resize and move graphic objects. This is the tool that’s in
your hand as soon as you enter Graphics Mode.

The Cross Hairs are great for critically aligning objects. Select it for use along with the
Pointer tool.

The Magnifying Glass is to enlarge the display in graphics windows for fine tuning. Shift-
click to reduce the display.

The Text tool is used to edit Text. Be sure to see the section on Text Blocks earlier in this
chapter for details on this very important tool.

The Tile tool creates tiles. It’s also used to re-assign tile types.Don’t use it unless you know
what you’re doing.

The Line tool is used for drawing line. Use the Graphics menu to select the line width, pat-
tern and color.

The Rectangle tool draws squares and rectangles. Color or shade them, drop them behind
text.

The Rounded Rectangle draws rectangles with soft shoulders.As with the rectangle tool,
you can add shades and colors.

The Oval draw circles and ovals.

R e p o
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ACCOMMODATE OR ADD YOUR LoaGo

PRINTED STATIONERY

If you use pre-printed stationery, you can adjust InView and StockView forms to accommodate any
pre-printed areas. Typically logos and header information are at the top of your stationery. Measure
the distance from the top edge of your paper to the bottom of the last line of your header. That is
the size of blank space you need above the first text box on the Body tile in the your report forms.
If you pride yourself on being atypical and your logo and address are elsewhere, follow the same
procedure. Measure and adjust the size of text boxes as necessary. Hold the Shift key as you resize
to maintain either the vertical or the horizontal dimensions.Be sure to run a test print to check the
new placement. Some printers do not print margins exactly as they appear on-screen because of the
way they feed paper through the printer. Make minor adjustments on-screen until you achieve exact
placement on the print out.

CoMPUTER GENERATED LoOoGo

Create a logo in any graphics or image editing software and use it in HindSight software forms. The
instructions above for making space to accommodate a logo apply whether it is pre-printed or dig-
itized. We know computer generated logos gobble up storage space and can slow down your work
pace. Despair not.

InView and StockView can use one digitized logo in any number of places without increasing the
demand for disk space and memory by each additional use. EZ Graphics looks for this logo.

Save your logo as a BMP, PICT, JPEG or TIFF image. If your computer has lots of processing
power and tons of memory, a big graphics file is no problem. In most cases though, it’s best to keep
it under 100K.

Name your graphic document exactly “Logo”. Place it in the same folder with all your HindSight
software files.

Many reports, such as the reports in Worksheet and Stocksheet, are ready to use it. Open those
forms, one at a time, and choose Company Logo in the Company Info menu. Go to the Company
menu again and choose On. Your Logo appears near the upper right of the first page. You can use
this one logo in as many report forms as you like.

Use EZ Graphics or Graphics Mode to position the logo where you want it to appear in your print-
out.

In Worksheet and Stocksheet Report forms you want it in the 1st Page Header tile. If you need to
change the dimensions of the display area for your logo, you must use Graphics Mode.

If you want to add your logo to reports that have no Company Info menu, install your logo proper-
ly in a form that does have the Company Info menu and do a test print-out to be sure it’s working
correctly. When you’re sure it works, activate Graphics Mode then click on the logo and Copy it to
the Clipboard. Now you can Paste the logo anywhere you want it

ADVANCED USERS
The full blown version of Panorama has tools to create and modify Flash Art beyond what we’ve
provided. You can use multiple logos and graphics, named however you wish. Panorama Direct
users are not offered these luxuries, but you can upgrade if it means enough to you.

LoGco TROUBLESHOOTING
If your logo doesn’t appear, check to see that it is the format that you think it is. Be sure that it’s
loose inside the HindSight software folder along with all the other files. On the desktop, View the
HindSight folder listed alphabetically by Name. Your logo, named Logo, should be listed right
along with Flow Chart, HS 3 Resources and all the other HindSight files. It is there? OK.

Maybe you entered the graphic’s name, Logo, incorrectly. (no extra spaces, no variation in case
allowed!)

S AVE

Until you Save, your graphics changes are only theoretical. That's great as you experiment and use
Revert to Saved when things don't work out. Once you're satisfied, though, use Save to preserve
your masterpiece. The Save command is your friend. Save after doing anything you’re sure you
want to keep. Save before you do something risky that you may want to undo. You can redeem
yourself from a mistake, serious or minor, using Undo from the Edit menu (Cmd/Ctrl-Z) of
Graphics Mode or the Revert to Saved command in the File Menu and have another go at it. Save
when you really need to keep it. Oh, yes, and back up your data!

HindSight Ltd.
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TRANSFER CHANGES TO A WORKING CopPY

Presuming there is no valuable data to lose, you can replace the entire working file with the modi-
fied copy. You can also transfer one whole report at a time or parts of a report. These instructions
also work if you made a mess and need to retrieve the “as shipped” form or if you’ve loaded an
update and want to bring your customized graphics into the new files.

To Copy and Paste all or parts of a report, from one file to another, have both files, the modified
copy and the working (or Master) file open and the report in each open and in Graphics Mode.

Note: You can’t have two files with the same name open at the same time. As long as your modifi-
cations copy has a different name, such as Worksheet copy, you can open both at once.

In the modified copy, Select All to copy the complete report form or select the parts you changed
(Shift-click to select several parts at once).

Copy the selection to the Clipboard.

Now, go to the working report form, still in the Graphics Mode. Select the part or parts you are
replacing (or Select All Objects, if that’s the plan). Hit the Delete key or choose Clear in the Edit
menu to remove the selected parts. Clear avoids using the Clipboard which holds your valuable
revisions.

Paste from the Clipboard to your working file report. Save your transferred work and give yourself
a pat on the back.

TERMS & CONDITIONS

Most of the reports printed by Worksheet and Stocksheet have standardized terms and conditions
that are typically printed on the back side of invoices, estimates, delivery memos and such. These
reports are all accessible via the Reports menus of Worksheet and Stocksheet.

As shipped they are intended only as samples and are no substitute for the advice of your attorney
and/or accountant. HindSight can not and will not assume responsibility for the results if you use
these samples in the course of conducting your business.

Now that we’ve got the disclaimer out of the way, feel free to use the terms and conditions, reword
them to meet your needs, or eliminate them all together.

If you choose to reword them, the wording can be edited and changed within each report one by
one. You don’t have to get into Graphics Mode. Just click the cursor inside the text box of the Footer
and add to or replace the text. Or you can access them all in one place for easier and more consis-
tent editing using the T&C Editor as described below.

Within your InView & StockView folder is a folder named Terms & Conditions. It contains sever-
al files that are the actual source of the wording for all of those reports. When you edit the words
within the reports, your changes are saved in the Terms & Conditions folder.

Each of the files in the Terms & Conditions folder is named for where it is utilized.

There is no need to print or open the documents directly. They can only be opened or accessed for
editing through Worksheet, Stocksheet or the T&C Editor. They can only be printed from the
matching report forms in Worksheet and Stocksheet. 7ip §

Changes are immediately and permanently applied to the matching Terms & Conditions file.
INSTALLING TERMS & CONDITIONS

The HindSight Extras folders contains folders named for a variety of graphic arts professions: pro-
fessional photography, graphic design or illustration. The Terms & Conditions folder inside the
folder that applies most closely to your profession should be dragged into your InView and/or
StockView folder in order to have those terms used in your printed reports. It should replace any
Terms & Conditions folder already in the InView & StockView folder rather than go inside it.

Note: The programs ship with the photographers’ terms already in place.

Very Important: The files must be loose in the Terms & Conditions folder and their names must not
be changed. The Terms & Conditions folder must be inside the InView & StockView folder and not
buried in any additional folders.

T&C EDITOR

The T&C Editor, included in the folder, allows you to quickly access and edit all of these forms.
They make use of the built-in word processing capabilities to allow you to include various fonts,
sizes and styles within a single block of text.

To edit any of the Terms & Conditions, open the T&C Editor. Use the popup menu in the top left
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Tip:

The Invoice and
Estimate Terms in
Worksheet and the
Submission and
Leasing Terms in
Stocksheet include a
popup menu to select
other terms from the
Terms & Conditions
folder or to create or
rename terms.

These forms default to
whichever terms in
the folder bear their
names - exactly.
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Note:
External Custom
Forms is a new fea-
ture and may not yet
be included in all of
your InView &
StockView files. The
Contacts and
Catalogue are the first
to have this feature.

Warning!

Although this dialog
gives you the option
to insert the new
form within a list of
all existing forms
and windows in the
file, don't do it. If
you insert it into the
wrong position It
won't be recognized
as a Custom Form
and you'll never
again be able to ac-
cess it.

Tip:
In Catalogue, if you in-
clude the word
“Label” in an internal
Custom Form name,
the custom label is
listed as one of the
available labels in the
Label Templates
popup menu.

Tip:
You can create
Custom Forms by
modifying existing
forms. Open any exist-
ing form in the file and
put it into Graphics
Mode. In the Edit
menu choose Copy
Form and then Paste
Form. Rename the
form - don't use the in-
sert option - and click
the Paste Form but-
ton. You now have an
exact copy of the origi-
nal form to start mak-
ing modifications. This
form is automatically
included in the list of
custom forms.

HindSight Ltd.
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corner to select the specific set of Terms & Conditions to edit. Make changes as desired. See the
chapter on Correspondence if you’re unfamiliar with the use of the Text menu and Ruler.

Warning! There is no Save or Revert in the File menu of the T&C Editor. Any changes you make
in the T&C Editor are immediately applied to the file. You cannot make changes, then go back to
a previous version unless it’s by restoring a back up copy of the individual file(s) to the Terms &
Conditions folder.

CusToM FoOoRrRMS

N E w

CREATING AN

In addition to the forms built into files, in several you have the ability to create your own Custom
Forms. They can be saved externally in a separate file named Custom Forms, or in Contacts and
Catalogue, these forms can be added to the file itself as internal forms. The benefit to external forms
is that they survive upgrades to the file and, especially in the case of Catalogue are accessible by
other Catalogues. An external envelope can be used by several files.

The Custom Forms dialog window lists any existing ' @ ) () Contacts Custom Forms

custom forms in the file plus any forms you’ve
entered for the Custom Forms file. Beside the list are
several buttons giving you several options for dealing
with your custom forms.

Rolodex file cards
Large Envelope

#10 Envelope
Marketing Report k
Client List

Print

Nesw

OPEN

Click to highlight one of your custom forms then Edit
click Open to open it for printing or editing. You can
also double-click on the name in the list.

Rename

Delete
In Contacts and Catalogue, New begins by asking if
you are adding a NEW form within the file itself or a

Custom form in an external Custom Forms file. Close

Thiz i a list of wour Custorn Forms, whether
they're bult into this file or ina Custom Forms
file of wour rmaking. Double click on any ane to
apen itf.

In this case, a click on New opens a second dialog for
naming and for creating a new internal form within
the file. Enter a name for this new form and click on
Paste Form to create it. You can now edit the empty
new form. € Warning! € Tip

An advantage to internal forms is that they have a set of menus specifically designed for the file -
ready to work on printing, searching and just about anything else you care to do in the file.

If you click on Custom, the program simply asks for the name of the Custom Form, adds it to the
list and stops. The assumption is that you are creating, or already have, a form of your own in a file
named Custom Forms. See Creating External Forms at the end of this section.

EpiT

Click to highlight a custom form then click Edit to open it for graphically editing it’s layout. The
selected form is opened for modification.

RENAME

Rename makes it easy to remember what you’ve designed the form to do. Forms can be renamed
over and over again.

DELETE

Click to highlight one of your custom forms then click Delete to remove it from the list.

CLOSE

Get outta Dodge fast. Close closes the Custom Forms dialog window.

INTERNAL CusTOM FORM

As we said above under New, the forms are empty blanks, although each contains a full set of the
file’s menus. It’s entirely up to you to make the forms anything your heart desires or ignore their
existence. Graphics Mode lets you control which tiles, fonts and everything else go into the form.
You can even create your own data input window rather than a mere report form. If you’re not
familiar with Panorama’s graphics tools, now’s the time to start learning. Go to the Getting Started
chapter, study up and then create to your heart’s content. 7ip §

Note: Although you may discover ways to create your own buttons and other elements, connecting
them properly is another matter and may prove frustrating or even futile. Help in these areas is a
pay-as-you-go proposition which could be educational for you and profitable for us.
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CREATING EXTERNAL FORMS

External Custom Forms are created in a Panorama database of your own making. The file must be
named exactly Custom Forms and it must be in the same folder as your other InView & StockView
files or they won’t be able to find and use it.

External Custom Forms have the huge advantage of being immune to loss of your customization
when the InView & StockView files are replaced by backups or upgraded. External Custom Forms
are able to print anything from your InView & StockView files using your customized graphic
design.

CREATE A CusToM FORMS FILE

A Custom Forms file is created by going to the File menu of any InView & StockView file and
choosing Open File. In the ensuing window, click on New Database. A new Panorama file named
Untitled opens on your screen. Return to the File menu and choose Save. You’re asked to name the
file. Give it the name of Custom Forms (we suggest that you click on the option to Save Window
Positions) and save it into your InView & StockView folder.

m Fields Text Search Sort M

f Dara Sheet Custom Forms
Design Sheet

CREATE A CusTtTOM FORM

To add Custom Forms to your Custom Forms file,
click on the View menu, choose New Form and
give the form a name. You now have a new, blank
form to work with. This new form is entirely under
your control from start to finish. You can build
your own report within in it or copy a layout from
another file, paste it here and modify it.

Note: Be sure to open any InView & StockView

files meant to use this new form and add the Data Sheet
name to the list of Custom Forms for use by that Design Sheet

file. New Form...
Envelope

E

(]

.........

As you add more Custom Forms, the View menu
lists them. This is your access to those forms.

Catalog Envelope °
Invoice
Letterhead Invoice

Panorama offers different sets of graphics tools
based on the level of Panorama you’ve licensed.
In most cases Panorama Direct provides an ade-
quate set of editing tools. The full, but higher
priced, Panorama does offer some higher end graphics editing capabilities
although most of the additional tools are of more interest for programming pur-
poses.

EEESECRDREEERL

Working with Panorama’s Graphics Mode can be simple or daunting depending
on the degree of your ambitions. Ultimately it’s your responsibility to learn how
to use the graphics tools. This chapter offers some basic tips on Panorama’s
Graphics tools. The HindSight web site has a growing library of How To PDF
files in the Reference section that includes Graphics Editing. The most extensive infor-
mation is available in the documentation for Panorama, available at provue.com.

An easy way to get started with a new Custom Form is to borrow from an InView or
StockView file. Open the file and the desired form. Put the form into Graphics Mode.
Choose Select All Objects from the Edit menu and Copy.

With your Custom Form in Graphics Mode, choose Paste from the Edit menu and the
entire copied layout appears in the window. Warning

Within the Custom Forms file, Graphics Mode in your Custom Forms is accessed by
clicking on the T-square and Triangle in the upper left corner, at the top of the Tool palette.
It’s the same tool used for getting out of Graphics Mode.

One problem you’re likely to encounter right away is that the field names and for-
mulas in your form don’t seem to work. That’s because they’re trying to use data
and fields that don’t exist in your Custom Forms file. Not to worry, we’ve solved
that one for you.

Be sure that the Custom Form itself is not in Graphics Mode. Open the Custom
Forms dialog window in the file the form is to work with. Highlight the form name
in the list and click on the Edit button. The Custom Forms file is opened and the
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Tip:

Typically Worksheet
limits you to two in-
voice forms and two
estimate forms;
Summarized and
[temized. By using
Custom Forms you
can create an unlim-
ited number of for-
mats for these and
other reports.

Warning!

Although you can
choose and use
Copy Form and
Paste Form, it has
hazards in this case.
Copy Form includes
menus from the
InView & StockView
file that will not
work in your own
Custom Forms file.

&




rinting & E diting R e p orts

320
form is displayed. The you’re asked if you’d like the file filled with sample data. Answer Yes, and
the Custom Files fields are converted to match those of the InView & StockView file that triggered
the action and they are filled with data from that file. You can now edit the form, preview and even
print using real data and getting accurate feedback.

PRINTING CusTOM FORMS
To Print an external Custom Form, open the Custom © ~c C F *
Forms dialog in the file for which the printing is to be LX) SIACS Suslom Zors
done. Highlight the desired report and click Print.

[Rolodex File Cards
The Custom Form is opened and used for the print-  |Largs Envelope :
; #10 Envelope Print
Ing process. Marketing Report
Client List itz

Envelope

il

IT OUGHTA BE IN MOVIES
And so it is. See our movie on Custom Forms by visiting the Reference Library in the Support sec-
tion of our web site at http://hsltd.us/reference/howto/howto.html

HindSight Ltd.




